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Frequency Counting Using Arduino

Objectives:
After performing this lab exercise, learner will be able to:

« Work with Arduino IDE

« Program Arduino board as a simple frequency counter

« Practice working with measuring equipment and laboratory tools
like digital oscilloscope and signal generator

« Use digital oscilloscope to debug/analyze the circuit

Equipment:

To perform this lab experiment, learner will need:

« Digital Storage Oscilloscope (TBS1000B-Edu from Tektronix or
any equivalent)
« Signal generator (AFG1000 from Tektronix or equivalent) for
providing AC input to circuit
« Arduino Uno or equivalent board (could be any other
openSource Arduino clone) with its USB cable
« Electronic Components
o Resistor (10K and 470 ohms)
o Switche (Push-to-on)
o LED
« BNC cables
« Breadboard and connecting wires



Theory / Key Concepts:
Before performing this lab experiment, it is important to learn
following concepts:

« Arduino is a popular open-source microcontroller board that
support rapid prototyping of embedded systems.

« Arduino also provide a custom, easy-to-use programming
environment (or IDE) for developing a program and flashing it on
the Arduino board. For more details, refer - www.arduino.cc

« Arduino can be programmed as frequency counter:

o Frequency input can be applied to pin # 2 of Arduino board.
This pin corresponds to interrupt O of the controller.

o An Interrup Service Routine (ISR) can then be used to count
the number of pulses in a given time window.

o Alternatively, we can find the period between successive
pulses and estimate frequency of the input signal.

o A switch can be used to initiate 'counting' of the frequency
input applied to pin # 2.

« The frequency estimated can be shown on the serial monitor.

Flowchart / Program:
Learner can understand the logic of frequency counter code using
given flowchart:



No

=

@
23
£ £3
s 3 ol

= [=]

52 ¢ " 2 g 3
=Rl g © &5
(==l = [
o ac = 35

S T g @ =
= = @ B
285 . -
(= <4 L =
g =g
£ S E

©
=

iZ

Interrupt Service
Routine (ISR)

o
=
b= o [
= @ Z o @ = o - o
5 S S5 5z E E M oz £z g ga
= B g = = 3 =g n g 5 £
e o = I g -5 w 2 z n
2 2 c c Il = £ = o m o c Il
" = =} ) = E . o =
@ =2 S = = @ = o o =§ = @ o o
2 g = =l -] = s E G &£ 3 g3 £t =l
T = w Y W* "] 89"- L o " O = o e x o S T @
E & S 3 £ Ll S S s 8 £ o W= g 3 o 35
= c = @ = -~ £ [-% =
=2 = o Pl T © 54 > P == P o
© g 9 5 o= i = °
t o & -5 c T = c 2 = = & o= — £ c @
= S 2 £ & —r=d u —» =] o = o .2 S
2 4= 25 = 2 2 = 3 = 2% S E g S E =
w ) 4= =] g = T 5 o £ s 3 © 2 ER= =] T % g e
= X = = a 28 =] - 2= 30 S E B2 b=
S © = =43 o £ > c £ 9 = = 5 = =
= = wn E s [=} = = 5] v E
k= = © [ It .= = = = 8 W a
H &~ g e © & o 2 c's 2 o © 2 a © 4= o £
g = EE =l e - z 3
o =~ @ @ =l = @ 2 v = %
: Wz g8 1 H M K ikl E =3
= 5] g2 o @ s fra} s 2 = o2
2 [=} e = ] = [=} & £s
[-]
Z| T

Arduino_Frequency_Counter -- Procedures
Step 1
Check Your Understanding:

Before performing this lab experiment, learners can check their
understanding of key concepts by answering these?

« What is the command / instruction for enabling interrupt in
Arduino sketch (program)?
o attachlinterrupt
o nolnterrupts
o yesinterrupts
o interrrupts

« For a pulse count of 12 in a measurement window of 10mS,
what will be the frequency of input signal?
o 12 Hz
o 120 Hz
o 1200 Hz
o 12000 Hz

« What will happen to frequency counter if the signal input (pulse,
square wave or sinewave) has amplitude swing from 0 to 2V:
o it will normal
o it will report frequency as double of actual value
o it will not work as signal amplitude is less than 2.5V
o it will work intermittently

Step 2



Circuit diagram / Connection Details

« Using the jumper / connecting wires prepare the circuit as
shown below - Choose Rpyjiyp = 10K & R gp = 470 ohm.

« Feed the output from AFG / Signal Generator to pin 2 of the
Arduino
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Pull-Up : 10K Ohms

Step 3

Experiment Setup

- Make the arrangement as shown in figure below (arduino clone is being

used here) =




« PC is connected to Arduino via USB cable

« Use AFG to generate a square wave and connect AFG output to
pin 2 of Arduino

« Connect oscilloscope channel 1 to AFG output so that same
signal is viewable on oscilloscope (that is fed to Arduino)

Step 4
Make the Circuit Work

« Flash the code on Arduino
« Use signal from AFG/signal generator to feed at Pin 2 of Arduino
« Set square wave from channel 1 of the AFG
o amplitude =0 - 3V
o frequency = 1K Hz
« Autoset the oscilloscope to see this waveforms
« Press the button on Arduino pin 7 - You should see the
measurent LED getting ON for a moment and frequency value
appearing on Serial Monitor on PC.

Step 5

Taking the Measurements

« Set input
o Square wave, 0-3V peak-to-peak amplitude
o 100 Hz frequency
o Continous mode (on AFG)
o enable the channel 1 output on AFG

» Autoset the oscilloscope to optimally see the signal
« Set up following measurements:
o On Ch1 - Frequency and Period

« Keeping the amplitude of the square wave input fixed, vary its
frequency from 1Hz to 20kHz.

« Measure frequency on oscilloscope

« By pressing the push button, get measurements from Arduino,
for each input set.

« Tabulate the measurements. You can also capture screenshot



for each measurement set.
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Step 6

Analyzing the Result

100.0us

1 @D Frequency

10.00kHz
J( ch1 7 1.48v

« The observation table would look like as shown below. Calculate
the % deviation of frequency measured by Arduino from actual.

INPUT

freq (Hz)

20,000
10,000
5,000
1,000

200
100
50
10

« Create a plot of Arduino Vs Actual frequency values

1
2
3
4
5 500
6
7
8
9

1

FREQUENCY (Hz) MEASURED BY

Oscillosocpe

20,000
10,000
5,000
1,000
501
200
100

50

10

Arduino
20833.0
10204.0

5000.0
998.0
499.5
199.9

99.9
49.9
10.0
5.0
1.0

PERIOD (uS) MEASURED BY

Oscillosocpe

49.99
100.00
200.00

1,000.00
2,000.50
5,001.00
10,000.00
20,000.00
1,00,000.00
2,00,000.00
10,00,000.00

Arduino
48
98
200
1002
2002
5002
10002
20002
100002
200002
1000018

DEVIATION

Frequency

4.17
2.04
0.00
-0.20
-0.30
-0.04
-0.10
-0.20
0.00
0.00
0.00

Period

-0.04
-0.02
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00



Frequency Measurement
Oscilloscope Vs Arduino measurements
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« Plot the % deviation with respect to actual frequency values

Frequency Measurement - Deviation from Actual
Arduino measurements deviation Vs Actual Frquency
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« Can you guess why the deviation increases to 4% for 20kHz
signal?

Step 7

Conclusion
The analysis of the observed results confirm that (As expected):

« The Arduino can be used for frequency counter application

« Frequency measured by Arduino system matches the actual
frequency value of the input

« Deviation increases as the input frequency is increases beyond
10KHz



How to program Arduino?

STEP: 1. Obtain Arduino board (preferably Uno, Duemilanove or Leonardo model)

STEP: 2. Download the IDE from - http://arduino.cc/en/Main/Software - that is suitable for
your PC operating system (to program your Arduino board).

STEP: 3. Install the Arduino IDE software on your PC. This is how IDE would look like:

(Colog
= dual sine wave

#include "avr/pgmspace.h"

[/ table of 256 sine values / one sine peried / stored in flash memory

PROGMEM prog_uchar sine256[] = {
127,13@,133,136,139,143,146,149,152,155,158,161,164,167,178,173,176,178,181,184,1
247,243,244 ,245,247 248,249,249, 250,251 ,252,252,253,253,253, 254,254,254, 254, 254, 2
221,21%,217,215,212,210,288,205,203,200,198,195,192,190,187,184,181,178,176,173,1
76,73,70,67,64,62,59,56,54,51,49,45,44,42,39,37,35,33,31,29,27,25,23,21,20,18,16,
33,35,37,39,42,44 ,45,49,51,54,56,59,62,604,67,70,73,76,78,81,84,87,90,93,96,99,102

I
#define cbi(sfr, bit) (_SFR_BYTE(sfr) &= ~_BV(bit))
#define sbi(sfr, bit) (_SFR_BYTE(sfr) |= _Bw{bic))

int ledPin = 13; /f LED pin 7
int testPin = T3 -



http://arduino.cc/en/Main/Software

STEP: 4.

STEP: 5.

Connect the Arduino board using USB cable provided to your PC. Wait till the

necessary drivers are installed and device is recognized as COM port.

USB Cable

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

Dual_Sine_ty

5 Serial Menitor Ctrl+5Shift+M

) ne

Modified by Board \
Serial Port '
Programmer "

Burn Bootloader
#include "avr/pgmspacem

f// table of 256 sine values / one sine period /

PROGMEM prog_uchar sine256[] = {
127,130,133,136,139,143,146,149,152,155,158,16]
242,243,244 ,245 ,247,248,249,2459,250,251,252 ,25]
221,219,217,215,212,218, 208,205,203, 200,198, 195
76,73,70,67,64,62,59,56,54,51,49 46,44 ,42 ,39,3]

33,35,37,39,42,44 ,46,49,51,54,56,59,62,64,67,7(

I8
#define cbhi{sfr, bit) (_SFR_BYTE(sfr) &= ~_BV(bi1
#define sbi(sfr, bit) (_SFR_BYTE(sfr) |= _BV(bit]

int ledPin = 13; { LED pin T
int testPin = T;

!

@ Arduino Uno
Arduine Duemilanove w/ ATmega328p
Arduino Duemilanove w/ ATmega32d
Arduine Diecimila or Duemilanove w/ ATmegal6s
Arduino Mano w/ ATmega328
Arduino Mano w/ ATmegal68
Arduino Mega 2560 or Mega ADK
Arduino Mega (ATmegal280)
Arduine Leonardo
Arduino Esplora
Arduine Micro
Arduino Mini w/ ATrmega328
Arduino Mini w/ ATmegalbd
Arduino Ethernet
Arduino Fio
Arduine BT w/ ATmega328
Arduino BT w/ ATmegal 68
LilyPad Arduino USE
LilyPad Arduino w/ ATmega328
LilyPad Arduino w/ ATmegalbd
Arduine Pro or Pro Mini (5, 16 MHz) w/ ATmega328
Arduine Pro or Pro Mini (3Y, 16 MHz) w/ ATmegalb8
Arduine Pro or Pro Mini (3.3V, 8 MHz) w/ ATmega328
Arduine Pro or Pro Mini (3.3V, 8 MHz) w/ ATmegalb8
Arduino NG or older w/ ATmegal6d
Arduino NG or older w/ ATmega8

File Edit Sketch

m

)5,198,200,202
i3,253,252,252
i1,158,155,152
.8,9,7,6,5,5,4
115,118,121,1

0 Uno o



STEP: 6. Ensure that COM Port identified for your Arduino board is correct. You can also
change / select appropriate COM Port your Arduino is connected as from following
menu: Tools > Serial Port >

fe:g\ Dual_Sine_Wave_Phase_Controlled: Arduinc ERW 1.0.4

File Edit Sketch [T Help

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

Serial Monitor Ctrl+ShiftsM | i

Cual_Sine_iM:

Board

m

You can def Serial Port 1 COML
E e COMG
v | com4a2

Programmer L

Burn Bootloader
#include "avr/pemspace

// table of 25 e values

PROGMEM prog_uchar sine2sse[] = {
127,130,133,136,139,143,146,149,152,155,158,161,164,167,170,173,176,178,181,184,187,190,192,195,198, 200, 203
242,243,244 ,245,247 248, 249,249,258 ,251,252,252, 253,253,253, 254,254, 254 , 254, 254 , 254,254,253 ,253, 253,252, 257
221,21%9,217,215,212,210,208,205,203,200,198,195,192,190,187,184,181,178,176,173,170,167,164,161,158,155,15:
76,73,70,67,64,62,59,56,54,51,49,46,44,42,39,37,35,33,31,29,27,25,23,21,20,18,16,15,14,12,11,10,9,7,6,5,5,¢
33,35,37,39,42,44,46,49,51,54,56,59,62,64,67,70,73,76,78,81,84,87,90,93,96,99,102,105,168,111,115,118,121,1

i8]
wdefine cbi(sfr, bit) (_SFR_BYTE(sfr) &= ~_BV(bit))
wdefine sbi(sfr, bit) (_SFR_BYTE(sfr) |= _

fint ledPin = 13; / LED pin 7
Hnt testPin = T; -
< 1 | +

STEP: 7. Once the setting is complete, we are ready to download the program on Arduino
board. We can test the setup by programming Arduino bard with an example code
(sketch). Go to : File > Examples > 01.Basics > Blink

@ sketch dec20s: Arduino ERW 1.0.4 =R
[[Fite] Edit_Sketch Tools Help
New CtrleN
Open.. Ctri+0
Sketchbook [
Examples '\ OLBasics } AnslogResdSerial
Close Ctriew 02.Digital Vo BareMinimum
save Ctrles 03.Analeg Y Bk
Save As... Ctrl+ Shift+5 D4.Communication | DigitalReadSerial
05.Contral Vo Fade
Upload Ctri+U
06.5ensors } ReadAnslogValtage
Upload and then Open Serial Monitor Ctrls M
07.Display v
Uplead Using Programmer Ctrl+ Shift+U
08.5trings v
Page Setup Ctrl+ Shifts P 09.USE v
Print Ctrl+P 09.USB(Leonards)  *
»
Preferences Ctil+ Comma e
ArduinolsP
Quit Ctri+Q
EEPROM v
Esplora v
Ethernet v
Firmata v
GsM v
LiquidCrystal v
) 3
Servo v
SoftwareSerisl v




STEP: 8. Click on the Right Arrow button (highlighted in orange color in the image below) to
compile and upload the binary to Arduino board. Once the upload is done, you will see
‘orange LED’ on board flashing — on for 1 second and off for 1 second.

@ Blink Arcuino ERW 1.04 (= |

File Edit Sketch Tools Help

This example code ds dn the public domain.

*f

routine runs once when you press reset

nitialize the digital pin as an output.
dode(led, OUTPUT);

m

the loop routine runs over and over
void loop() {
talWrite(led, HIGH);

y {199@)-,
talWrite(led, LOW);
delay(le@0);

Auduine Duemilano

STEP:9. Now that setup is successfully completed and tested, open the relevant program (.ino
file as specified by the lab experiment) using menu option — File > Open

STEP: 10. Using UPLOAD button (circular button with arrow pointing to right) we can compile
the program and upload the compiled binary file to Arduino board.

STEP: 11. Once the board is programmed, it will start generating signals at specified pins. The
board is ready to probe (or to connect external RC circuits) as per lab needs.
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